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Experiment HE-9: Resting, Active, and Exercising Metabolic Rates
Background
During the day, we expend energy at levels that are related to the activities that we are performing. The
rate at which energy is utilized, or the metabolic rate, can be classified into one of three levels: resting,
active, and exercising. The energy expended is usually measured indirectly by measuring the rate at
which oxygen is consumed during an activity. This method is known as indirect calorimetry.
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Humans usually burn 70-80% of the calories that are burned each day at the resting level. These are the
calories needed to maintain life. The measurement of the resting metabolic rate (RMR) is performed
under the following conditions:
The subject should not ingest any food during the 12 hours prior to the test.

•

The subject should be physically and mentally relaxed.

•

The core temperature of the subject should be normal.

•

The temperature of the room in which the test is conducted should be comfortable. A
temperature that is a few degrees above or below 24oC (75oF) is suitable.
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•
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The calories burned during normal daily activities, like walking, working at a computer, and digesting
food, are included in the active level of metabolism. To obtain an accurate measurement of the calories
expended during an activity, the resting metabolic rate is subtracted from the total metabolic rate
recorded during the activity.

Energy Sources
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During exercise, calories are expended in proportion to the intensity of the exercise. Again, to
accurately determine the amount of energy expended during exercise, the resting metabolic rate is
subtracted from the total metabolic rate recorded during the exercise.
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The energy requirements of the body are met with a mixture of energy derived from carbohydrates,
fats, and protein. The activity being performed and the stores of carbohydrates and fats available as
energy sources determine the proportion of the three macromolecules that are utilized by the body. At
rest, a body derives about 40% of its energy from carbohydrates and 60% from fats. As the intensity of
activity and the demand for energy increase, a greater proportion of the energy is usually provided by
the oxidation of carbohydrates. At the most intense exercise level, all the energy that is required is
usually being supplied by carbohydrates.
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Protein is usually not a significant source of energy in the body. Unlike fat and carbohydrates in the
form of glycogen, the body has no storage deposits of protein. Proteins are important components of
tissues, peptide hormones, and enzymes that are continually being broken down and replaced.
However, during periods of exercise that are greater than 90 minutes, it is estimated that protein
catabolism provides as much as 15% of the energy required. If the body’s supply of stored
carbohydrates is low from a prior exercise period, protein catabolism could provide as high as 45% of
the energy required. Because of its importance in tissues, the utilization of protein as an energy source
could cause damage to these tissues. Severe damage to tissues does occur during long-term starvation,
when protein is the principal source of energy.
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Indirect Calorimetry
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The expenditure of energy can be measured directly using a body calorimeter to measure the amount of
heat produced by the body during the burning of calories. Since the number of calories burned and the
heat produced during an activity are directly proportional to the amount of oxygen consumed during
that activity, the metabolic rate for that activity can be measured indirectly by determining the amount
of oxygen consumed during the activity. If the amount of carbon dioxide produced during the activity is
also measured, the types and proportions of energy source being utilized during the activity can also be
determined.
When examining the oxidation of the three macromolecules used as energy sources, it is shown that the
stoichiometries of the reactions for each type of molecules are significantly different.
The oxidation of a molecule of carbohydrate is expressed by the following equation:
6 O2 + C6H12O6 = 6 CO2 + 6 H2O + 38 ATP
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As shown in this equation, 6 molecules of carbon dioxide are produced for every 6 molecules of
oxygen consumed during the oxidation of carbohydrates, a ratio of 1.0.
The oxidation of a molecule of fatty acid is expressed by this equation:

23 O2 + C16H32O2 = 16 CO2 + 16 H2O + 129 ATP
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As shown in this equation, 16 molecules of CO2 are produced for every 23 molecules of O2 consumed
during the oxidation of fatty acids, a ratio of 0.7.

xS

As the ratio of energy supplied by fats and carbohydrates shifts during changes in activity, the ratio of
carbon dioxide produced to oxygen consumed also shifts. The ratio of carbon dioxide produced to
oxygen consumed during cellular metabolism can be measured by determining the changes in the
concentrations of oxygen and carbon dioxide in the air that passes into and out of the lungs. These
measurements are possible because the amounts of oxygen and carbon dioxide exchanged between the
alveoli and the capillaries in the lungs are directly dependent on the amounts of carbon dioxide
produced and oxygen consumed during cellular respiration.
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The amounts of oxygen consumed and carbon dioxide produced are measured using an oxygen/carbon
dioxide gas analyzer connected to a spirometer. The gas analyzer measures the concentration of oxygen
and carbon dioxide in inspired and expired air, and the spirometer determines the volumes of inspired
and expired air. When the concentrations and volumes are brought together in a series of equations, the
volume of oxygen consumed per minute, known as VO2, and the volume of carbon dioxide produced
per minute, known as VCO2, are determined. The ratio of VCO2/VO2 is the Respiratory Exchange
Ratio (RER), which can be used to determine the proportion of carbohydrates and fats utilized, and the
energy expended per liter of oxygen consumed, during an activity (Table HE-9-B1).
The fat and carbohydrate percentages utilized during an activity are determined using the following
equations:
((1.00-RER)/(1.00-0.70)) x 100 = % Fat utilized
100% - % Fat utilized = % CHO utilized
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When heart rates are recorded in conjunction with the rates of oxygen consumption and carbon dioxide
production, the effectiveness of different activities to burn calories from fat or carbohydrates, or total
calories can be determined.by examining the RER at different heart rates. For example, if the RER of a
subject is 0.75 at 85 beats per minute (BPM) and 0.90 at 115 BPM, the subject more effectively burns
fat at 85 BPM than 115BPM (Table HE-9-B1).
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Energy Expenditure
The energy expended during an activity is calculated from the RER and the volume of oxygen
consumed. For example, if the RER is 0.90, the energy expended is 4.92 kcal/liter O2. If 2.5 liters of
oxygen are consumed per minute for 20 minutes, a total of 246 kcal are expended during the activity:
(2.5 LO2/minute)(20 min)(4.92 kcal/liter O2) = 246 kcal
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At less intense activity levels, the rates of energy expenditure and RER values are lower. To expend the
same amount of energy at a less intense level of activity, the duration of activity must be longer. For
example, if the RER is 0.80, the energy expended is 4.80 kcal/liter O2. If 1.7 liters of oxygen are
consumed per minute, 8.16 kcal are expended per minute:
(1.7 LO2/minute)(4.80 kcal/liter O2) = 8.16 kcal/min
To expend 246 kcal at a rate 8.16 kcal/min would require 30 minutes, 9 seconds:
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246 kcal/(8.16 kcal/min) = 30.15 minutes
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Table HE-9-B1: Respiratory Exchange Ratio (RER) as a Function of the Proportions of Energy
Sources.
Energy (kcal/liter O2)

% Energy from CHO

% Energy from Fats

0.70

4.69

0

100

0.75

4.74

15.6

84.4

0.80

4.80

33.4

66.6

4.86

50.7

49.3

4.92

67.5

32.5

0.95

4.99

84.0

16.0

1.00

5.05

100

0

0.85
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0.90
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RER
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In this experiment, students will measure the VO2, VCO2, and heart rate of a subject while he or she is
resting while reclining; performing an activity, like reading or working on a computer while sitting;
and, exercising at various levels of intensity from easy to moderate. From these measurements, the
subject’s RER, proportion of energy sources utilized, and effectiveness of cardiac fitness will be
determined.
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These measurements will be performed quickly and easily using an iWire-GA CO2/O2 gas analyzer
connected to a spirometry system and a heart rate monitor.
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Experiment HE-9: Resting, Active, and Exercising Metabolic Rates
Equipment Required
PC or Mac Computer
PHRM-220 PolarTM heart rate monitor
FH-1000 Spirometer flow head and plastic tubes
iWire-GA CO2/O2 Gas Analyzer with filter, sample tubing
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IXTA Data acquisition unit, power supply and USB cable

A-GAK-201 Reusable mask, head gear, and non-rebreathing valve
A-CAL-150 Calibration kit
Rubber adapter, 3.5cm O.D. to 2.85cm I.D.
5 Liter mixing chamber
Treadmill or exercise bike

Setup the IXTA and iWire-GA

am

3 Liter Calibration syringe
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Flexible tubing, 61 cm long, 3.5cm I.D. (2)
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1. Connect the iWire-GA to the iWire1 port on the front of the IXTA, and plug it into the wall
using the power supply.
2. Plug the IXTA into the wall and, using the USB cable, to the computer.
NOTE: The iWire-GA must be plugged into the IXTA prior to turning both machines on.
3. Turn on the IXTA and the iWire-GA.

or

4. Open LabScribe.

5. Click Settings → Human Exercise-iWireGA → RestActExerMetabolism.
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6. Once the settings file has been loaded, click the Experiment button on the toolbar to open any
of the following documents:
•
•
•
•

Appendix
Background
Labs
Setup (opens automatically)

Setup the Metabolic Cart
1. Locate the A-FH-1000 flow head and tubing in the iWorx kit (Figure HE-9-S1).
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Figure HE-9-S1: The A-FH-1000 flow head, and airflow tubing.

2. Carefully attach the two airflow tubes onto the two sampling outlets of the A-FH-1000 flow
head and the other ends of the two airflow tubes onto Channel A1 on the front of the IXTA
(Figure HE-9-S4).
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Note: Make sure to connect the airflow tubing so that the ribbed tube is attached to the red outlet port
of the flow head and also to the red inlet port of the spirometer. The smooth side of the tubing attaches
to the white ports.
3. Locate the mixing chamber in the iWorx kit (Figure HE-9-S2).
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4. Connect the inlet of the A-FH-1000 flow head to the outlet of the mixing chamber (Figure HE9-S3).
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Note: Be sure to connect the flow head to the mixing chamber so that the red outlet port is facing
towards the mixing chamber.

Figure HE-9-S2 and HE-9-S3: The mixing chamber showing the 1000L/min flow head connected to the
outlet.
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5. Locate the non-rebreathing valve, mask, and smooth interior tubing in the iWorx kit (Figure
HE-9-S5).
6. Attach one end of the smooth interior tubing to the inlet of the mixing chamber (Figure HE-9S6), and the other end to the outlet of the non-rebreathing valve. There are arrows on the valve
that indicate the direction of air flow.

or

xS
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7. Attach the mask to the side port of the non-rebreathing valve.
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Figure HE-9-S4: The iWire-GA gas analyzer connected to an IXTA. All tubings are connect properly in
this image.
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Figure HE-9-S5: Mask, non-rebreathing valve, and smooth interior tubing.
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8. On the iWire-GA, place one filter on the “Room Air” port, place a second filter on the “Sample
In” port. Attach the braided end of the Nafion sampling tube to the filter on the “Sample In”
port.

or
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9. Place the other end of the Nafion sampling tube on the gas sampling port near the outlet of the
mixing chamber (Figure HE-9-S6).
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Figure HE-9-S6: The assembled devices used during metabolic studies. The assembly includes: the
mixing chamber, smooth interior tubing, Nafion sampling tubing, flow head, spirometer, nonrebreathing valve, and mask.
10. Plug the outlet tubing from the iWire-GA to the port on the mixing chamber, opposite the flow
head.
11. Locate the PHRM-220 Polartm heart rate monitor transmitter, electrode belt, and receiver in the
iWorx kit (Figure HE-9-S8).
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12. Plug the connector of the PHRM-220 receiver into the “HR” input on the iWire-GA.
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Figure HE-9-S8: The PHRM-220 transmitter, belt, and receiver set.
The non-rebreathing valve can be used with the attached mask or with an optional mouthpiece.
If the subject is using a mask (preferred method):
Attach the head gear to the mask.

•

Attach the non-rebreathing valve to the mask. Depending on the model of the mask, an adapter
may be required.

•

Instruct the subject to try on the assembly. Adjust the straps so that the mask fits the subject
comfortably. Make sure there are no leaks around the mask.
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•

If the subject is using a mouthpiece:

Attach the headgear to the brackets on the non-rebreathing valve. The pair of straps with the
narrowest spacing go over the top of the subject’s head.

•

Connect the mouthpiece to the side port of the valve so that the valve is oriented horizontally,
and the saliva trap of the mouthpiece is pointed downward.

•

Instruct the subject to try on the assembly. Adjust the straps so that the mouthpiece fits the
subject comfortably. Make sure there are no leaks between the mouthpiece and the valve or
around the mouthpiece.
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•

The gas analyzer must warm up for at least 15 minutes.
Note: For increased accuracy, users must complete the flow Head Calibration procedure. Please see
Appendix I for directions on how to perform this calibration. The calibration of the 1000L flow head
requires a 3L Calibration Syringe.
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Load a PreSaved flow Head Calibration (*.iwxfcd) File
Note: This procedure is used once a calibration curve has been generated using the Spirometer
Calibration directions in Appendix I.
All of the following directions will be prompted by the software. Follow the directions as they
pop up on the LabScribe software.
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1. Load the lab settings file you wish to perform as stated in the “Start the Software” section
(Figure HE-9-S9).
2. Assemble the spirometer, flow head, tubing, mixing chamber and calibration syringe as shown
in Appendix I or in the SpirometerCalibration directions.
3. Click the Setup button shown in the left side window. Follow the directions as prompted by the
(Figure HE-9-S10). The Online Setup Dialog window will open
Enter your subject's information or Load a subject from a previously saved file.

•

Click “Settings” to change any parameters you wish to view (Figure HE-9-S11).

or
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•
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Figure HE-9-S9: Initial screen for starting a Fitness Assessment test. Follow the directions as
prompted by the buttons on the left side of the window.
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Figure HE-9-S10: Online Metabolic Setup Dialog window.

Figure HE-9-S11: Settings dialog of the Online Metabolic Setup window.
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4. Perform the Quick Flow Calibration by clicking the button and following the prompted
directions (Figure HE-9-S12).
When you click “Load”, you will be prompted to load the .iwxfcd file created when you
performed the full flow head calibration.
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Figure HE-9-S12: Spirometer Calibration dialog window.

5. Select Save As in the File menu, type a name for the file. Click on the Save to save the data file.
Calibrating the iWire-GA Gas Analyzer
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Note: Warm up the gas analyzer for at least 15 minutes prior to use. Make sure the calibration gas
tank is located close to the gas analyzer.
This procedure will calibrate both the O2 and CO2 channels.
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Connect the gas sample tubing of the A-CAL-150 Calibration Kit (Figure HE-9-S13) to the Luer-Lock
connector on the output of the regulator.

Figure HE-9-S13 Calibration
Kit (A-CAL-150).
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1. Click the Calibrate Gas Analyzer button. Click Perform Quick Software Gas Calibration.
2. Follow the directions as prompted. Room air will be sampled for 10 seconds. Calibration gas
will be sampled for 15 seconds.

xS
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3. If necessary, move the cursors into correct position (Figure HE-9-S14).

iW

or

Figure HE-9-S14: Advanced units conversion dialog for room air and calibration gas.
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Appendix I: Initial Spirometer flow head Calibration
For accuracy of measurements, users must include this calibration procedure as part of the
Exercise Physiology Lab protocol.
It is suggested that this procedure be followed at the beginning of every term and when using a new
flow head-spirometer combination.
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Note: This calibration protocol precedes the actual calibration of the GA-200 or GA-300 gas analyzer.
You will not need the gas analyzer at this time.
Note: Whenever you will be using a different flow head, you will need to repeat this calibration
procedure from the beginning by loading a new Spirometer Calibration settings file.
1. Open the LabScribe software.

2. Click Settings - Human Exercise-iWireGA. Choose SpirometerCalibration to launch the
calibration settings file.
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3. Assemble the flow head, tubing, mixing chamber and calibration syringe.
4. Plug the tubing into the internal spirometer channel A1.

Connect the flow head to the IXTA using the flow head tubing, making sure that the
ribbed side of the tubing connects the red marked port on the flow head to the red
marked port on the spirometer (Figure HE-9-S15).

•

Connect the smooth side of the tubing to the other ports.
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•
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5. Connect end of the1000L flow head with the red marked onto white flange of the mixing
chamber. Make sure the tubing is in an upright direction (Figure HE-9-S16).

Figure HE-9-S15: The 1000L flow head and Figure HE-9-S16: The 1000L flow head attached to the
mixing chamber showing the tubing in an upright position and the red port facing the mixing chamber.
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Figure HE-9-S17: 1000L flow head connected to the mixing chamber, showing the Nafion tubing
connected to the outlet sampling port near the flow head.
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Note: Make sure the red port on the flow head faces into the mixing chamber.

6. Connect one end of the smooth bore tubing to the 3L calibration syringe as shown in Figure
HE-9-S18).

or

xS
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7. Connect the other end of the smooth bore tubing to the mixing chamber, opposite the flow head
(Figure HE-9-S19).
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Figure HE-9-S18: 3 liter calibration syringe connected to the smooth bore tubing and Figure HE-9S19: The smooth bore tubing connected to the mixing chamber.
8. If also setting up the gas analyzer at this time:
•

Connect the braided Nafion tubing to the filter on the gas analyzer and to the flow head
side of the mixing chamber. Make sure the braided end is connected to the filter (Figure
HE-9-S17).

•

Connect the thin flexible tubing from the outlet of the gas analyzer to the port next to the
smooth bore tubing on the opposite side of the mixing chamber.
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9. If not using the gas analyzer at this time, connect the flexible tubing from the port on one side
of the mixing chamber to the port on the other. This ensures there is no air leaking from the
chamber.
10. Pull the plunger on the 3L Calibration Syringe all the way out until it stops.
11. Click the Record button.
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12. Wait for at least 10 seconds of recording so that there is no flow of air moving through the
syringe.
13. Push the plunger in all the way until it stops. Pull the plunger out all the way until it stops.
14. Repeat the procedure in Step 13, for at least 50 repetitions, varying the speed and force on the
plunger. Make sure to pause between strokes.
15. The faster the speed of the stroke, the higher the flow through the calibration syringe.
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Note: Ideally the flow head calibration recording should span air flow values to include the minimum
to maximum flow levels for the particular experiment being conducted.
16. After at least 50 repetitions have been performed, wait at least 5 seconds after the final
repetition and then click Stop.
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17. Select Save As in the File menu, type a name for the file.

18. Click on the Save button to save the raw data for generation of a flow head calibration *.iwxfcd
file.
19. Click AutoScale on the Air flow channel.
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20. Use the Display Time icons to adjust the Display Time of the Main window to show the
complete calibration data (Figure HE-9-S20).

iW

or

21. Click the Double Cursor icon so that two cursors appear on the Main window.

Figure HE-9-S20: The LabScribe toolbar.
22. Click Advanced on the main toolbar. Then click Metabolic, and Calibrate flow head (Figure
HE-9-S21).
23. Place the two blue vertical cursors so that:
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The left-hand most cursor is on the flat line prior to the start of the calibration data.
Make sure the cursor is at the beginning of the 10 second baseline.

•

The right-hand most cursor is on the flat line after the final calibration stroke (Figure
HE-9-S22).
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Figure HE-9-S22: Calibrate flow head dialog window.
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24. In the new window that opens (Figure HE-9-S24), enter these values:
•

flow channel = Expired Air flow

•

Baseline = Use the first 10 seconds as zero

•

Calibrate difference between cursors to 3 L.
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25. Click the Calibrate the difference between cursors to button. This will generate the curve as
shown above.
26. A new window will open prompting you to Save your file as an *.iwxfcd flow head calibration
file. Name your file and click Save.
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27. Click OK.

Note: At this point, a raw calibration data file (*.iwxdata) and a flow head calibration file (*.iwxfcd)
have been generated.
28. Exit LabScribe or open a Human Exercise lab settings file.
Note: Once a saved *.iwxfcd file is loaded, a simple 5-10 stroke calibration procedure can be used to
update the file for immediate use.
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Figure HE-9-S23 The calibration recording showing the vertical cursors in the correct position for
generating a calibration curve. Note – the recording you generate should look similar to this.
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Figure HE-9-S24: Calibration syringe data.
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Experiment HE-9: Resting, Active, and Exercising Metabolic Rates
Before Starting
1. Read the procedures for the experiment completely before beginning the experiment. Have a
good understanding of how to perform the experiment before making recordings.

La
b

2. It is important that the subject is healthy and has no history of respiratory or cardiovascular
problems.
3. Allow the spirometer to warm up for 15 minutes before recording for the first time.

4. Determine if the airflow tubes between the flow head to the spirometer amplifier are attached to
the proper inlets on each device.
Since this test does not need to be recorded, click on the Save to Disk button in the lower
left corner of the Main window. If LabScribe is in Preview mode, there will be a red X
across the Save to Disk button.

•

Click on the Preview button.
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Note: If the user clicks the Preview button and an error window appears on the Main window
indicating the iWorx hardware cannot be found, make sure the iWorx unit is turned on and connected to
the USB port of the computer. Then, click on the OK button in the error window. Pull down the
LabScribe Tools menu, select the Find Hardware function, and follow the directions on the Find
Hardware dialogue window.
Have the subject inhale and exhale through the mask 2 or 3 times while the complete
spirometry circuit is assembled.

•

Click on the AutoScale button at the upper margin of the Expired Air Flow and Lung
Volume channels.

•

If the proper end of the flow head is attached to the outlet of the mixing chamber, the
traces on the Air Flow and Lung Volume channels will go up when the subject exhales.

•

If the traces on these channels go down during exhalation, remove the flow head from
the outlet of the mixing chamber and place the other end of the flow head on the outlet
of the mixing chamber.

iW

or

xS

•

•

Click on the Stop button.

5. Click on the Save to Disk button, in the lower left corner of the Main window, to change
LabScribe from Preview mode to Record mode. If LabScribe is in Record mode, there will be a
green arrow on the Save to Disk button.
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Exercise 1: Resting Metabolic and Heart Rates
Aim: To determine the amount of oxygen consumed (VO2), carbon dioxide produced (VCO2),
respiratory exchange ratio (RER) in relation to the heart rate of a resting subject.
Procedure
1. Instruct the subject to sit quietly, become accustomed to breathing through the spirometry
equipment, and breathe normally before any recordings are made.
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2. Once the subject and recording equipment are all prepared, disconnect the smooth-bore tubing
from the mixing chamber to ensure that no air is entering the system at this time.
3. Type <Subject’s Name> Inhalation at Rest in the Mark box that is to the right of the Mark
button.
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4. Click on the Record button. After waiting ten seconds for the Expired Air Volume ATP channel
to zero, reconnect the proper end of the tubing to the mixing chamber. Press the Enter key on
the keyboard to mark the recording.
Note: The LabScribe software will zero the Expired Air Volume ATP channel during the first ten
seconds of recording. No air should be moving through the flow head during this time.
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5. Click the AutoScale buttons on all channels.

6. On the Expired CO2 Concentration (%) channel, notice that the CO2 concentration increases in
the first few minutes of the recording and then reaches a near-steady level.
The time that it takes the chamber to be filled with expired air and reach a near-steady
level of carbon dioxide is dependent on the tidal volume and respiration rate of the
subject and the volume of the mixing chamber. It will take longer to fill the chamber if
the subject’s respiration rate and tidal volume are low, or the chamber is large.

•

Every breath exhaled into the mixing chamber pushes a matching volume of expired air
out of the mixing chamber.

•

Record baseline data, while the mixing chamber air is replaced with the subject’s
expired air, for approximately 5-10 minutes prior to beginning any experiments.

or
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•
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7. On the Expired O2 Concentration (%) channel, notice that the O2 concentration decreases in the
first few minutes of the recording and then stays a near-steady level. As pointed out in the
previous step, the size of the mixing chamber, the tidal volume, and respiration rate of the
subject, determine the time it takes for the concentration of oxygen in expired air to reach that
near-steady level.
8. On the Expired Air Volume channel, the STPD Volume-MC spirometry function converts the
data from the Expired Air Flow channel to the volumes of expired air at STPD. Notice that the
recorded volume increases in a ramp-like manner with each breath.
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Figure HE-9-L2: Gas concentrations and volumes of a standing subject displayed on the Main window.
Concentrations of gases reach a steady state after the mixing chamber is filled. Cursors placed one
minute apart indicate VCO2 is 0.284 liters/min and VO2 is 0.397 liters/min. Therefore, RER is 0.96.
9. Continue to record until one or more minutes of data are recorded while the concentrations of
oxygen and carbon dioxide in expired air are at a steady level. Once the appropriate duration of
data is recorded, click Stop to halt the recording. Your recording should be similar to the data
displayed in Figure HE-9-L2.
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10. Select Save As in the File menu, type a name for the file. Choose a destination on the computer
in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click
on the Save button to save the data file.

Data Analysis

1. Display the complete data recording in the Main window. Use the Display Time icons to adjust
the Display Time of the Main window to show the complete recording on the Main window.
Note: To simplify the display of data on the Main and Analysis windows, select an alternate view of the
window. Alternate views allows channels to be hidden from view on a window even though they may
still be used in computations that create channels still in view.
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•

Open the View menu, which is located to the right of the 1-Cursor icon on the LabScribe
toolbar, by clicking on the arrow to the right of the current view, Default View.

•

Select VO2-VCO2 from the list on the menu. This view is programmed in the settings
file for this experiment. The Expired Air Volume ATP and Expired Air Volume STPD
channels are hidden from view, but still used in the calculations for VO2 and VCO2.

La
b

2. Select and display the last 60-second section of the recording while the oxygen and carbon
dioxide concentrations were at a steady level on the Main window. Select the 60-second section
of the recording by:
•

Placing the cursors on either side of the 60-second section of data; and

•

Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HE-9-L3)
to expand the selected section of data to the width of the Main window.
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3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to
transfer the data displayed in the Main window to the Analysis window (Figure HE-9-L4).

xS

Figure HE-9-L3: The LabScribe toolbar.

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis
window. The mathematical functions, V2-V1, T2-T1, and Mean, should appear in this table.
Values for these two parameters on each channel are seen in the table across the top margin of
each channel.
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5. Once the cursors are placed in the correct positions for determining the carbon dioxide and
oxygen concentrations in expired air, the expired air minute volume at STPD, the VCO2, and
the VO2 of the resting subject, the values for these parameters can be recorded in the on-line
notebook of LabScribe by typing their names and values directly into the Journal.
6. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of these parameters from the recording to the Journal. To use these
functions:
•

Place the cursors at the locations used to measure the concentrations and volumes.

•

Transfer the names of the mathematical functions used to determine these concentrations
and volumes to the Journal using the Add Title to Journal function in the VCO2 Channel
pull-down menu.
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•

Transfer the values for the volumes and rates to the Journal using the Add All Data to
Journal function in the VCO2 Channel pull-down menu.

7. Use the mouse to click on and drag the cursors to positions on the Expired O2 Concentration
(%) channel that are one minute apart during the near-steady level of oxygen in the mixing
chamber (Figure HE-9-L4). The values for the following parameters are determined when the
cursors are positioned as directed:
Mean concentration of CO2 in expired air, which is the value for Mean on the Expired
CO2 Concentration channel.

•

Mean concentration of O2 in expired air, which is the value for Mean on the Expired O2
Concentration channel.

•

Air Volume at STPD expired in a minute, which is the value for V2-V1 on the Expired
Air Volume STPD channel.

•

Volume of carbon dioxide produced in one minute (VCO2), which is the value for V2V1 on the VCO2 channel.

•

Volume of oxygen consumed in one minute (VO2), which is the value for V2-V1 on the
VO2 channel.

•

Mean heart rate during the period, which is the value for Mean on the Heart Rate
channel.
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•

9. Record the values in the Journal using one of the techniques described in Steps 6 or 7.
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10. Record the values for the mean CO2 and O2 concentrations in expired air, the minute volume of
expired air at STPD, the VCO2, the VO2, and the heart rate while the subject was resting in
Table HE-9-L1.
11. Calculate the Respiratory Exchange Ratio (RER) of the resting subject by dividing the value for
VCO2 by the value for VO2. Record the values for RER in the data table.
12. Calculate the Relative VO2 of the resting subject by dividing the value for VO2 by the subject’s
body weight (kg). Record the values for Relative VO2 in the data table.
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13. Calculate the VO2/Heart Rate Ratio (VO2/HR) of the resting subject by dividing the value for
Absolute VO2 by the heart rate (HR) for the same period. Record the value for VO2/HR in the
data table.
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Figure HE-9-L4: Gas concentrations, air volumes, VCO2, VO2, and heart rate of a resting subject
displayed on the Analysis window. Cursors placed one minute apart indicate VCO2 is 0.284 liters/min,
the VO2 is 0.297 liters/min, and the mean heart rate is 72.044. Therefore, RER is 0.96 and the VO2/HR
is 4.122ml/min/beat.

Exercise 2: Active Metabolic and Heart Rates

iW

Procedure

or

Aim: To determine the amount of oxygen consumed (VO2), carbon dioxide produced (VCO2),
respiratory exchange ratio (RER) in relation to the heart rate of a active subject.

1. Use the same procedures used in Exercise 1 to record the lung volumes from the subject while
he or she is performing a typical daily activity.
2. Remember to record until at least two or more minutes of data are recorded while the
concentrations of oxygen and carbon dioxide in expired air are at a steady level. Once the
appropriate duration of data is recorded, click Stop to halt the recording.
3. Mark the recording with comments that indicate the name of the subject and the beginning of
each minute being recorded.
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Data Analysis
1. Use the same procedures used in Exercise 1 to determine the minute volumes of expired air,
oxygen consumed (VO2), and carbon dioxide produced (VCO2) during the activity.
2. Record the values for the mean CO2 and O2 concentrations in expired air, the minute volume of
expired air at STPD, the VCO2, the VO2, and the heart rate while the subject was resting in
Table HE-9-L1.
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3. Calculate the Respiratory Exchange Ratio (RER) of the resting subject by dividing the value for
VCO2 by the value for VO2. Record the values for RER in the data table.
4. Calculate the Relative VO2 of the resting subject by dividing the value for VO2 by the subject’s
body weight (kg). Record the values for Relative VO2 in the data table.
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5. Calculate the VO2/Heart Rate Ratio (VO2/HR) of the resting subject by dividing the value for
Absolute VO2 by the heart rate (HR) for the same period. Record the value for VO2/HR in the
data table.

Exercise 3: Exercising Metabolic and Heart Rates

am

Aim: To determine the amount of oxygen consumed (VO2), carbon dioxide produced (VCO2),
respiratory exchange ratio (RER) in relation to the heart rate of a subject performing light to moderate
exercise.
Procedure

xS

1. Use the same procedures used in Exercise 1 to record the lung volumes from the subject while
he or she is exercising at an easy level, like 3 km/hour (2 miles/hr) on a treadmill or 10 km/hour
(6 miles/hr) on an exercise bike.
2. Remember to record until at least two or more minutes of data are recorded while the
concentrations of oxygen and carbon dioxide in expired air are at a steady level.
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3. Continue to record as the exercise level is doubled to a higher level, like 6 km/hour (4 miles/hr)
on a treadmill or 20 km/hour (12 miles/hr) on an exercise bike. Remember to record until one or
more minutes of data are recorded at a steady level.
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4. Continue to record as the exercise level is increased to a higher level, like 9 km/hour (6
miles/hr) on a treadmill or 30 km/hour (18 miles/hr) on an exercise bike. Remember to record
until one or more minutes of data are recorded at a steady level.
Warning: The subject should stop exercising if they begin to feel any discomfort.
5. Mark the recording with comments that indicate the name of the subject, the level of exercise
being performed, and the beginning of exercise level being recorded.
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Table HE-9-L1: VCO2, VO2 and the Respiratory Exchange Ratio (RER) of a Subject at Resting,
Active, and Exercising Levels of Metabolism.

Units

Resting

%CO2

Exhaled [Oxygen]

%O2

Expired Minute Volume
STPD

L/min

Absolute VCO2

ml/min

Absolute VO2

ml/min

Heart Rate

beats/min

RER

Exercise
Level 1

Exercise
Level 2

Exercise
Level 3

am

Exhaled [Carbon
Dioxide]

Daily
Activity
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Barometric
Pressure______mmHg

Activities

ple

Room
Temperature_______oC

ml/min/kg

VO2/HR

ml/beat

xS

Relative VO2

Data Analysis

or

1. Use the same procedures used in Exercise 1 to determine the minute volumes of expired air,
oxygen consumed (VO2), and carbon dioxide produced (VCO2) during the activity.
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2. Record the values for the mean CO2 and O2 concentrations in expired air, the minute volume of
expired air at STPD, the VCO2, the VO2, and the heart rate while the subject was resting in the
above data table.
3. Calculate the Respiratory Exchange Ratio (RER) of the resting subject by dividing the value for
VCO2 by the value for VO2. Record the values for RER in the above data table.
4. Calculate the Relative VO2 of the resting subject by dividing the value for VO2 by the subject’s
body weight (kg). Record the values for Relative VO2 in the data table.
5. Calculate the VO2/Heart Rate Ratio (VO2/HR) of the resting subject by dividing the value for
Absolute VO2 by the heart rate (HR) for the same period. Record the value for VO2/HR.
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Questions
1. During which activity was the subject’s RER the highest? In which period was it the lowest?
2. During which activity was the subject consuming a higher proportion of fat calories?
3. During which activity was the subject consuming a higher proportion of carbohydrate calories?
4. During which activity did the subject consume the highest amount of total calories for the level
of cardiac activity?
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5. During which activity did the subject consume the highest amount of fat calories for the level of
cardiac activity?
6. Evaluate the physical fitness of your subject. How does the level of your subject’s physical
fitness correlate to his or her RER while resting, being active, and exercising?
7. Evaluate the diet of your subject. How does your subject’s diet correlate to his or her RER while
resting, being active, and exercising?
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8. How does your subject’s level of physical fitness, diet, RER, and cardiac effectiveness correlate
to those parameters from other members of the class?
Calculations: Calculate and Plot Metabolic Parameters
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Values for VO2, VCO2, RER, TV, and other parameters (Table HE-9-L2) from the segments of the test
can be calculated automatically by using the Metabolic Calculations window.
1. To use the Metabolic Calculations window, pull down the Advanced menu and select Metabolic.
Select Mixing Chamber: Offline Calculations from the submenu to open the Metabolic
Calculations Dialog window.
2. On the left side of the Metabolic Calculations window:
Pull down the CO2, O2, Volume, Heart Rate, and Energy Channel menus to select the
channels on which the CO2 and O2 concentrations, lung volumes, heart rates, and
workload were recorded.

•

When analyzed, the data file will be divided into time segments. The average of each
parameter in each segment will be reported in the data table on the Metabolic
Calculations window. Enter the time (in secs) in the Average box to select the time
length of each segment.

•

In the O2 and CO2 Concentrations in Inhaled Air boxes, enter the concentrations of
oxygen and carbon dioxide in the inhaled air, which is room air in most tests.
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•

4. Click on the Calculate button on the left side of the Metabolic Calculations Dialog window to
calculate the average value of each parameter listed in the table for each time segment of the
recorded data, and to plot the selected parameters against each other in the plot panel (Figure
HE-9-L5).
5. In the lower left corner of the plot panel, click on the arrow to open the pull-down menu listing
the types of plots (Table HE-9-L3) that can be made with the metabolic parameters calculated
by this analytical tool. Select the plot to be displayed in the plot panel when the calculations are
performed.
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Table HE-9-L2: List of Parameters Calculated on the Mixing Chamber Offline Metabolic
Window
Term

Parameter

Description

Units

Absolute VO2

Volume of oxygen (O2) consumed / minute

Liters/minute

Abs.VCO2

Absolute VCO2

Volume of carbon dioxide (CO2) produced
per minute

Liters/minute

Rel.VO2

Relative VO2

Volume of O2 consumed per kg body weight
per minute

ml/kg/minute

Rel.VCO2

Relative VCO2

Volume of CO2 produced per kg body weight
per minute

ml/kg/minute

RER

Respiratory
Exchange Ratio

Ratio of VCO2/VO2

None

REE

Resting Energy
Expenditure

5.46 (AbsoluteVO2) + 1.75 (AbsoluteVCO2)

kcal/day

METS

Metabolic
Equivalent of Task

1 MET = 3.5ml O2/kg/min or 1kcal/kg/hr

MET

O2 Min.

O2 Minimum exhalation

Minimum concentration of O2 recorded
during test period

Percentage

CO2 Max.

CO2 Maximum exhalation

Maximum concentration of CO2 recorded
during test period

Percentage

VE

Expired Tidal
Volume

Volume of air displaced during normal
exhalation

Liters/breath

P

Power

Workload during the stages of the test

Watts

Number of beats in a minute:
(60 sec/min) divided by the (secs/breath)

Beats / Minute
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Heart Rate
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HR
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Abs.VO2
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Table HE-9-L3: Plots Available on the Offline Metabolic Window.
Available Plots
VO2

VCO2

Ve

Ve

Y-Axis
VCO2
Parameter 2
RER

X-Axis
Parameter

Time

Vt

VCO2

VO2

VO2 VCO2

VO2

Ve

HR

VO2

Ve/VO2

VO2/
HR

VCO2

Ve/
VCO2

Ve Watts

Watts

Watts

Watts

RER

Watts
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Y-Axis
Parameter 3

HR

La
b

Y-Axis
Parameter 1
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Figure HE-9-L5: The metabolic parameters, and plots of VO2, VCO2, and RER vs. Time, displayed in
the Metabolic Calculations window used offline to analyze data collected during an aerobic fitness
test. Notice that the VO2 and VCO2 values increase quickly as the subject performs more strenuous
segments of the test.
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